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DDA MANAGEMENT BULLETIN
D19-014 – Procedure
July 29, 2019


	TO:
	DDA Field Staff

	FROM:
	Debbie Roberts, Deputy Assistant Secretary
Developmental Disabilities Administration

	SUBJECT:
	Person-Centered Service Plan Signature Requirements

	PURPOSE:
	To require case resource managers to obtain personal care provider signatures on a client’s person-centered service plan (PCSP)

	BACKGROUND:
	Under 42 C.F.R. 441.540(b)(9), a client’s PCSP must be finalized and agreed to in writing by the client and signed by all individuals and providers responsible for implementing the plan.   

In 2018 the State Auditor’s Office determined DDA was not consistently obtaining the signature of the provider and thus was out of compliance with federal rules. This resulted in a projected federal payback of $1,933,981, which is estimated to be a total of $170,353,801 in improper payments.

	WHAT’S NEW, CHANGED, OR CLARIFIED:
	Previously, case resource managers were directed to obtain only two signatures – their own signature and that of the client or the client’s legal representative. 

Effective immediately, the following signatures are required for a PCSP:

1. The signature of the client or the client’s legal representative;

2. The case resource manager’s signature; and

3. The signature of any providers assigned personal care tasks in the PCSP.




	ACTION:
	Case Resource Manager Responsibilities

The case resource manager must:

1. Schedule a client’s person-centered planning meeting with sufficient time to complete the plan and allow the client, legal representative, and providers at least ten days to review and sign the plan before it is effective; 

2. Sign the PCSP on or before the annual plan effective date ;

3. Ensure the client’s PCSP is also signed by:

a. The client, or the client’s legal representative if they have one; and

b. Any of the following people assigned and authorized to provide personal care tasks:

1) Individual providers;

2) A representative of the homecare agency supporting the client, if applicable;

3) A representative of the adult family home supporting the client, if applicable; and

4) A representative of the assisted living facility supporting the client, if applicable.

4. Ensure the providers listed above sign the PCSP as required by federal rule and return signed plans as soon as possible using a method that protects the client’s protected health information (e.g. secure e-mail, fax, or standard mail). 

5. Continue to send Assessment Details and PCSPs to each provider before authorizing services.

Missing Signatures

1. CMS requires a person-centered approach to obtaining client signatures. This means that the case resource manager may continue authorizing services until the client’s signature is obtained; however, the case resource manager must continue efforts to obtain the signature and document their efforts in an SER.

2. Services should not be terminated if a provider fails to sign the PCSP. If a provider does not sign the plan or indicate in writing that they agree with the plan, the case resource manager must document:

a. Steps taken in attempting to obtain the signature; and 
b. Methods used to confirm the provider agrees with the plan.         

Signatures for Amended PCSPs

1. The signature requirements above apply to all PCSPs amended or created as a result of an initial, annual, or significant change assessment.  

2. An amended PCSP that results in a change in provider or a provider’s assigned personal care tasks must be signed by that provider.  However, the plan does not need to be signed again by the case resource manager, client, or the client’s legal representative. 

3. An amended plan needs all signatures listed above under “CRM Responsibilities” subsection (3) any time the amendment changes:

a. A service type or service amount;
b. The client’s needs, goals or outcomes; or
c. The plan effective date.

Signature Format

1. All signatures do not have to be received on a single copy of the plan, but if more than one provider wants to sign the same copy of a plan, it is acceptable to have the providers sign in the blank space below the signature lines. 

2. Signatures may be in any format (e.g. written, electronic, stamp, etc.) that denotes the signatory agrees to the plan of care. The federal rule does not require a date or title, so if either is missing it is not necessary to resend. See attached instructions, Guide to Electronic Signatures. 

Signature Pilot Project

Several DDA staff will participate in a pilot project beginning mid-August 2019 to test the feasibility of obtaining signatures from clients, legal representatives, and providers via a completely electronic process.   


	RELATED REFERENCES:
	42 CFR 441.540(b)(9)
42 CFR 441.301(c)(2)(ix)
 

	ATTACHMENTS:
	


	CONTACTS:
	Jaime Bond, State Plan Services Unit Manager
bondjl@dshs.wa.gov 
360.407.1567

Dave Harding, QCC Unit Manager
hardidl@dshs.wa.gov 
360.407.1566
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Guide to Electronic  Signatures


Guide to Electronic Signatures
Guide to Electronic Signatures

These instructions will provide step by step instructions for the following:

e Create a location to save a pdf,

e Save a pdf document from CARE,

e Use the electronic signature function in a pdf document without any additional
equipment or software

Introduction

There are four documents within CARE that can be electronically signed:

CARE Service Summary

Client Rights and Responsibilities (16-172)
DSHS Consent (14-012)

Acknowledgment of Services (14-225)

P wnNpRe

For the following instructions, the CARE Service Summary will be used as an example.

SET UP STEPS:

A. Before saving your first pdf CARE Service Summary, you will first need to create a

file on your computer desktop to use specifically for electronic signature
purposes. To do this:
1. Right click your mouse in a blank area on your computer desk top. Select
“New” and then “Folder.”
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# Shortcut
View > 8
Sort by ) Bf Microsoft Access Database
Refresh @ Bitmap image
Contact
Paste

Microsoft Word Document
Microsoft PowerPoint Presentation

Paste shortcut

) Graphics Properties... Microsoft Publisher Document

E Graphics Options > D Text Document

& DisplayPort Topology @ Microsoft Excel Worksheet
New > 5 Compressed (zipped) Folder

2. Name the file something recognizable to you. For illustration purposes, the
file is named “Service Summary Signatures”

Surmmary
signatures

CARE STEPS:

Now that you have set up a folder location, you are ready to save a pdf CARE Service
Summary. To do this:

1. Ensure the correct Current assessment is selected in the CARE tree.

Eh McGee, Poppy X
- M Client Details

ERTTILTC Current*Annual 04-01-2019

- History

2. From the “File” menu in CARE, select “print forms”

B caRrE Office: ADSA HQ Case: McGee, Poppy X Updated By: AmesRL On: 04/01/2019 01:43

File Action Administration Help

Print > Print Forms Ctrl+P
Revert Panel Print $SPS Authorization
Save Panel Ctrl+5S Print Client Profile
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3. Select Service Summary from the “Available Forms” dropdown

. Select a Form for a Client

Available Forms:

Assessment Details
Service Summary
Care Results
 |Personal Care Results
PCRC Comparison

|

4. Click “Preview/Print”

[# select a Form for a Client

Available Forms:
Service Summary

OPrint For Translation

Preview/Print I Cancel

SAVE STEPS:

1. The Service Summary will open as a PDF. Notice in the top left corner, and on the
menu tab, that the pdf is already named.

HOD530305689798230070425190425195621234007.pdf - Adobe Ac
File Edit View Window Help 4=
Home Tools H0053030568979... x

B XN Q I
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2. From the “File” menu, select “Save As”

H00530303689793230070425190425195621234007.pdf - Adobe Acrobat Reader Dy

Edit View Window Help

E’ Cpen... Ctrl+0
Save As... I}, Shift+Ctrl+5
Save as Other b

3. When the dialogue box opens, find the folder you created in the first Setup Step
A above and navigate to the “Desktop” location and double-click on the
appropriate folder:

e ltis the folder you created (Service Summary Signatures)

Save As
« v s I » ThisPC » Desktop v | O Search Desktop el
Organize « Mew folder Bl o
~
[ This PC ~ MName Date modified Type Size
_J 3D Objects W CARE 5/2019 1:38 PM File folder
I Desktop DESKTOP 92:38PM  File folder
o D5HS Temnplates 9436 PM File folder
@ Documents
EASY CONTACTS 92:15PM  File folder
; Downloads - - = 5 -
) Service Summary Signatures 19 10:42 AM  File folder
D Music E:§ ALTSA-DDA Helpdesk 19811 AM  Shortcut 1KB
=] Pictures S Citrive 775 Internet Sharteut 1KR

4. You may change the file name from the autogenerated name if you’d like.

5. Click “Save”
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“« v A » This PC » Desktop » Service Summary Signatures v O Search Service Summary Sign... @

Organize « Mew folder Bz - o
I This PC ~ MName - Date modified Type Size
~J 3D Objects HOD53030568979823007042519042519562...  4/25/201910:42 AM  Adobe Acrobat D... 73KB
[ Desktop
Documents
* Downloads
b Music
[&] Pictures
B Videos
5 Windows (C:)
= amesrl (\\dshsfs
== Install (\\dshs.wi
= DATA1 (\\dshsa
= APPS (\\dshsapc v
File narme: | HOD53030568973823007042519042519562139763 5. pdf ~
Save as type: | Adobe PDF Files (*.pdf) ~

» Hide Folders [ Save | | Cancel

6. Now the Current Service Summary is saved in the correct location and ready to
be signed. Open the PDF document you want to sign or have signed.

SIGNATURE STEPS:
1. Click “Fill & Sign” found on the right hand side of your pdf screen.

5.pdf - Adobe Acrobat Reader DC - X

HO0053030568979.. x

Fo (E]

@ 14 RMm O @ o g P B 27 M Share

Services
Client is functionally eligible for: CFC + COPES Comment
Recommended Living Situation:
AFH (Adult Family Homes)-Metropolitan Counties A Fill & Sign X

Client Chosen/Planned Living Situation:
AFH (Adult Family Homes)-Metropolitan Countics LA L

The daily rate includes payment for four hours per month of assistance with participation in

individualized activities in the local community. Assistance includes the AFH provider

helping to make arrangements for preferred activitics and/or going along on the activitics

-

Comment

A Fill & Sign \

|Fi|| and sign documents electronicall
'u VIS OIS
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2. Click “Sign” and select “Add Signature” located near the top of your screen

® sl R @O
IA'J X v -] —_— L ] g;Sigr‘l h
ﬂ;’-‘xdclSignature [+

Transforming lives

Client Signature

| am aware of all alternatives available to me i s © es
to 24-hour care is available only in residentie e ni
residential settings. | agree with the above services outlined on this

summary.
+ | understand that participation in all ALTSA/LTC paid services is voluntary

haua a rimht tn Aaclina Ar tarminata canrirae at anu tima

3. Select “Draw” to sign. Signatures may be done with the actual mouse, using a
finger on the touch pad on a lap top, or using a finger on a touch screen tablet or

laptop
g (&

e Do

Save signature

Cancel

4. To sign using the handheld mouse:
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e Hold the left click button of the mouse while moving the mouse with your
hand.

e If the signer would like to erase and start over, click “clear” and start the
signature over. Once the signature is complete, click “Apply.”

v

Clear

Save signature k I
Cancel

e The signature screen will disappear and the signature will appear to float over
the page. Use the mouse to drag the signature to the signature line. Click the
mouse to drop it. You may resize the signature by dragging the blue dot at the

bottom right corner. By clicking on the signature you can continue to move the
signature around if needed.

Client/Representative signature Date
(A AW -
ﬁ:/c:ér Date

.si nature Date

Click and drag this blue dot to
resize the signature

e Click your cursor over the area you want to enter the date and a text box will
appear. Enter the date.
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5.

6.

Client/Representative signature Date

EEs
74 W\V 4/25/2019

Social Worker/Case Manager signature Date

B

e The signature and date fields are editable until you Save the PDF.

To sign using the touchpad on your laptop:

e Follow the same instructions above for the mouse

e Instead of pressing the left click button on your handheld mouse, hold down
the left button on your touchpad while using another finger to draw the
signature

To sign using a tablet or touchscreen
e Follow the same instructions above but use the functionality of the
touchscreen to make selections

e Use finger on the touchscreen to draw the signature

ADDITIONAL NOTES ABOUT PDF SIGNATURE:

When the “Save signature” box is checked, the signature that was applied will be
saved when the pdf is saved and available any time you sign a future pdf
document. This is useful in order to save your case manager signature. It can be
captured and used each time you need to place your signature on the document.

N
§

‘ Save signature =)
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e To access your signature the next time, go to step #2 of the Signature Steps
section and instead of “Add Signature” you will select the saved signature. You

can also delete the signature by clicking the next to the saved signature.

@ LY, Sign
o

Add Initials &

® Make sure the “Save signature” check box is not checked when a client or
provider is signing.

e Once you have saved the pdf you cannot edit a signature or date that has already
been applied. But you can add additional signatures and/or dates.
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